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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
No part of this document may be reproduced in any form or by any means, electronic or 
mechanical, including photocopying, without express written permission of Schneider Electric.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2017 Schneider Electric. All Rights Reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000001684 06/2017 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.
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About the Book
At a Glance

Document Scope
This document provides information to help you maintain the compatibility of your SoMachine 
application, project, device firmware, Vijeo-Designer application, device description, and other 
aspects of your installation, when migrating to more advanced versions of SoMachine and its 
supporting libraries and software.

Validity Note
This document has been updated for the release of SoMachine V4.3.

Related Documents

Document title Reference
SoMachine Functions and Libraries User Guide EIO0000000735 (ENG);

EIO0000000792 (FRE);
EIO0000000793 (GER);
EIO0000000795 (SPA);
EIO0000000794 (ITA);
EIO0000000796 (CHS)

SoMachine Programming Guide EIO0000000067 (ENG);
EIO0000000069 (FRE);
EIO0000000068 (GER);
EIO0000000071 (SPA);
EIO0000000070 (ITA);
EIO0000000072 (CHS)

SoMachine Central User Guide EIO0000001659 (ENG);
EIO0000001660 (FRE);
EIO0000001661 (GER);
EIO0000001663 (SPA);
EIO0000001662 (ITA);
EIO0000001664 (CHS)

SoMachine Device Type Manager (DTM) User Guide EIO0000000673 (ENG);
EIO0000000674 (FRE);
EIO0000000675 (GER);
EIO0000000676 (SPA);
EIO0000000677 (ITA);
EIO0000000678 (CHS)
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You can download these technical publications and other technical information from our website 
at http://www.schneider-electric.com/en/download.

Product Related Information

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

WARNING
LOSS OF CONTROL
 The designer of any control scheme must consider the potential failure modes of control paths 

and, for certain critical control functions, provide a means to achieve a safe state during and 
after a path failure. Examples of critical control functions are emergency stop and overtravel 
stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
8 EIO0000001684 06/2017
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Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in this manual, or 
that appear in or on the products themselves, are generally derived from the terms or definitions 
of international standards.
In the area of functional safety systems, drives and general automation, this may include, but is not 
limited to, terms such as safety, safety function, safe state, fault, fault reset, malfunction, failure, 
error, error message, dangerous, etc.
Among others, these standards include:

Standard Description
EN 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.
ISO 13849-1:2008 Safety of machinery: Safety related parts of control systems.

General principles for design.
EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.
ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and risk 

reduction
EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General 

requirements
EN 1088:2008
ISO 14119:2013

Safety of machinery - Interlocking devices associated with guards - Principles 
for design and selection

ISO 13850:2006 Safety of machinery - Emergency stop - Principles for design
EN/IEC 62061:2005 Safety of machinery - Functional safety of safety-related electrical, electronic, 

and electronic programmable control systems
IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: General requirements.
IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-

related systems: Requirements for electrical/electronic/programmable 
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2008 Digital data communication for measurement and control: Functional safety 
field buses.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive
EIO0000001684 06/2017 9



In addition, terms used in the present document may tangentially be used as they are derived from 
other standards such as:

Finally, the term zone of operation may be used in conjunction with the description of specific 
hazards, and is defined as it is for a hazard zone or danger zone in the Machinery Directive 
(2006/42/EC) and ISO 12100:2010.
NOTE: The aforementioned standards may or may not apply to the specific products cited in the 
present documentation. For more information concerning the individual standards applicable to the 
products described herein, see the characteristics tables for those product references.

Standard Description
IEC 60034 series Rotating electrical machines
IEC 61800 series Adjustable speed electrical power drive systems
IEC 61158 series Digital data communications for measurement and control – Fieldbus for use in 

industrial control systems
10 EIO0000001684 06/2017
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Chapter 1
General Information

General Information

Overview
SoMachine and the devices supported by SoMachine are continuously improved. Therefore, new 
updates of SoMachine and its associated supports are released on a regular basis.
SoMachine Software provides, in most cases, a simple, and straight forward way to migrate 
projects created with previous versions of SoMachine to the current version.
NOTE: 
 We encourage you to launch the Schneider Electric Software Update (SESU) regularly to obtain 

the latest SoMachine updates.
 You should also visit regularly the Schneider Electric website www.schneider-electric.com to 

download the latest device firmware available.
In specific situations, you may encounter compatibility concerns regarding these updates, and 
actions are required to establish consistency with your existing systems and project files for the 
following elements:
 SoMachine files created with a previous SoMachine version (projects, archives, exports)
 device firmware versions (controllers, HMI terminals)
 related software (Vijeo-Designer)
EIO0000001684 06/2017 11



General Information
SoMachine Software
By installing a new version of SoMachine, new component versions are available, which include:

Component Description
Compiler version The compiler is the software that converts your project into the binary code that is 

downloaded and executed on the controller.
The compiler is called when you execute a Build, Build All, Rebuild, or Generate Code 
action in SoMachine. The version of the compiler used is independent of your 
SoMachine version and can be defined by selecting: Project → Project Settings → 
Compile options
By default, the latest compiler version is selected and most often you will want to keep 
this default.

Device description 
version

The device description defines the properties of a device such as configurability, 
programmability, and possible connections to other devices.
When you insert a device inside a project, SoMachine uses the device description to 
define the properties of the device.
The device description version is displayed in the Information tab of the device of your 
project:

Library version A library is a container of variable lists, data structures (DUTs), functions, and function 
blocks (POU) that can be used in your projects. The versions of libraries used in an 
application are visible in the Library Manager (see SoMachine, Functions and Libraries 
User Guide).
12 EIO0000001684 06/2017



General Information
There are 2 types of project files which are created by SoMachine:

The following elements can have compatibility concerns between SoMachine versions:
 Project files (see page 17)
 Archives files (see page 17)
 Device firmware (see page 23)
 Vijeo-Designer software (see page 35)

Device Firmware
The firmware is the software embedded in the controller.
The firmware version is displayed in the Connect Controller screen in the SoMachine Central and 
in the SoMachine Logic Builder Controller Selection dialog (see SoMachine, Programming Guide).

Vijeo-Designer Software
The Vijeo-Designer software allows you to create your HMI applications.
The SoMachine installation includes the installation of Vijeo-Designer but this software is 
independent of SoMachine and can be installed or updated without the SoMachine software.
For compatibility information with Vijeo-Designer, refer to Compatibility of SoMachine and Vijeo-
Designer versions (see page 35)

File Type Description
*.project
*.library

The version of a SoMachine project/library file is determined by the application file 
version and the application profile.
application file version: The version of the application file is defined by the version of 

SoMachine that saved this application file. It acts as a container that specifies the 
storage format for the content of the application.

application profile: The application profile contains the versions of device descriptions, 
the versions of the libraries used, the compiler version, and the visualization profile 
(refer to Visualization part of SoMachine online help). The application profile 
applies to all the applications of the project/library.

When a SoMachine project has an additional application (Vijeo-Designer/SoMachine 
Basic), it is saved in the *.project file.

*.projectarchive A project archive can be created by using SoMachine and be saved on your PC as a 
*.projectarchive file. This file contains one project and can contain download 
information files, referenced devices, and referenced libraries.
You can also do a source download to create an archive as an Archive.prj file in your 
controller.
EIO0000001684 06/2017 13



General Information
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Chapter 2
Compatibility Situations

Overview
This chapter provides information on compatibility situations you may encounter when you install 
a new version of the SoMachine software, acquire a new device or a new version of Vijeo-Designer 
software.

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
2.1 Using a New Version of SoMachine Software 16
2.2 Using a New Version of Vijeo-Designer Software 24
2.3 Using a New Controller 25
EIO0000001684 06/2017 15



Compatibility Situations
Using a New Version of SoMachine Software

Section 2.1
Using a New Version of SoMachine Software

Overview
This section describes the compatibility situations you may encounter when installing a new 
version of SoMachine.
Refer the SoMachine Installation and Configuration Manager User Manual for information about 
installation procedure.

What Is in This Section?
This section contains the following topics:

Topic Page
Using Existing SoMachine Projects 17
Creating a Project in a New SoMachine Version 22
Using a Device with an Earlier Firmware Version 23
16 EIO0000001684 06/2017



Compatibility Situations
Using Existing SoMachine Projects

Overview
You can use existing projects created with a previous SoMachine version by different ways:
 Open a *.project file
 Extract Archive a *.projectarchive file
 Source Upload a *.prj file from a controller
Using a project archive is the preferred method for migrating a project because a .projectarchive 
file contains the following additional information that are not included in a .project file: 
 download information file
 libraries
 device description files
When you extract the archive in the new SoMachine version, the device and library files can 
automatically be installed into the corresponding SoMachine repositories.

NOTICE
LOSS OF DATA
Always make a backup of your project file before you use it with a new SoMachine version.
Failure to follow these instructions can result in equipment damage.
EIO0000001684 06/2017 17



Compatibility Situations
When you open a project that was created with an earlier SoMachine version than the version you 
are using, the Update project dialog box is displayed:
18 EIO0000001684 06/2017



Compatibility Situations
Using Your Legacy SoMachine Projects
Starting with SoMachine V4.1, it is possible to install different full versions of SoMachine (available 
on DVD or USB) in parallel.
NOTE: SoMachine V4.1 SP1 replaces SoMachine V4.1. It is not installed in parallel.
There is no need to uninstall an existing version of SoMachine before you start the installation of 
a new SoMachine version.
Therefore if you do not intend to use the latest features and functions of the new SoMachine 
version, open your legacy project with the version it was created with.

Element Description
Compiler version Current version and New version of the compiler software. The compiler is the 

software that converts your project into the binary code that is downloaded and 
executed on the controller.
Refer to Compiler version (see page 12) and to SoMachine/CoDeSys Compiler 
Version Mapping (see page 44).

Visualization profile Current profile and New profile of the visualization.
The Visualization profile defines
 the names and versions of the Visualization Libraries which get 

automatically included in the project when a visualization object is created.
 a selection of visualization elements provided by the included libraries.

For detailed information, refer to the Visualization part of the SoMachine online 
help.

Devices list If you click OK, the devices listed in the Current device type and version column 
are updated to the devices in the New device type and version column.

Libraries If the Update all libraries option is activated and you click OK,
 the direct referenced libraries are updated.
 the libraries with at least one forward compatible library version installed in 

the Library Repository and the version mapping of former legacy versions 
will be updated to the latest forward compatible library version.

NOTE: The placeholder libraries are updated even if the Update all libraries 
option is not selected.
For detailed information, refer to Updating Libraries and Library References 
(see SoMachine, Functions and Libraries User Guide).

OK Click OK to update
 the complier version when saving the project.
 the visualization profile.
 the devices according to the selected new version in the Update project 

dialog box.
 the libraries if the check box Update all libraries is activated in the Update 

project dialog box.
Cancel Click Cancel if you do not want to make any changes to your project.
EIO0000001684 06/2017 19



Compatibility Situations
Using Your SoMachine Projects with Update
If you wish to take advantage of the features and functions of the new version of SoMachine, you 
will want to update your projects.
Click OK if you want to update your project to the new version of SoMachine.
The following elements are updated:
 the complier version when saving the project,
 the visualization profile.
 the devices according to the selected new version in the Update project dialog box
 the libraries if the check box Update all libraries is activated in the Update project dialog box
A build and a download of the project to the controller is necessary after the update.
NOTE: Any errors that are detected during the update process are displayed in the Messages view 
(see SoMachine, Menu Commands, Online Help) of Logic Builder.
For a description of this command, refer to the SoMachine Menu Commands Online Help section 
of the SoMachine Online Help.
NOTE: 
After the update of the project,
 you may encounter device firmware compatibility issues (see page 23),
 you will no longer be able to open the project in an earlier SoMachine version.

Using Your SoMachine Projects Without Update
If you do not want to make any changes to your project and still want to be able to connect to a 
controller to which the original project was downloaded, select Cancel in the Project update dialog.
NOTE: If you do not update your project, the latest functionalities of SoMachine are not available.
In this case the following message is displayed:

Click OK in this message box to confirm for not updating your project.

If you do not update your project, you may encounter that the code generated by this SoMachine version is 
not the same as the one generated by the SoMachine version the project was originally built with. To help to 
ensure full compatibility, use the corresponding SoMachine version.
Click OK to continue, being aware of this issue.
Click Cancel to return to the Update project dialog.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Always verify that your application program will operate as it had under the previous compiler 

version within SoMachine.
 Thoroughly test the newly compiled version with the version of the device firmware compatible 

with the new version of SoMachine.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
20 EIO0000001684 06/2017



Compatibility Situations
For more information on how to reduce the effect of a new version of SoMachine on your projects, 
refer to the migration practices (see page 27).
You can log in to your controller without building and downloading the project only if a Download 
Information Files file (*.compileinfo) was created in the same directory as the project on your PC.
Refer to Code Generation, Compile Information (see SoMachine, Programming Guide).
NOTE: If your projects include or are based on HMI, the HMI runtime is updated during the 
download of the project (see page 33).

Updating Single Devices Individually
If you click Cancel in the Update project dialog box, the devices in your project are not updated.
To update single devices individually, refer to the updating devices part (see SoMachine, 
Programming Guide) of the online help.

Using Legacy Device Repositories
To use legacy repositories (for example device repositories, library repositories, and so on) of an 
earlier SoMachine version installed in parallel to your current SoMachine version, proceed as 
follows:

Step Action Comment
1 In the SoMachine toolbar (see SoMachine 

Central, User Guide), click the System Options 
icon.

The General Options tab of the System 
Options dialog box is displayed.

2 Click the Logic Builder Options button. The Options dialog box of the SoMachine 
Logic Builder is displayed.

3 Select Directories (Devices, Libraries, ...) in the 
list on the left-hand side.

The Directories (Devices, Libraries, ...) dialog 
box of the SoMachine Logic Builder is 
displayed.

4 Activate the Include legacy repositories check 
box.

Now you can use the legacy repositories in 
your SoMachine project.
EIO0000001684 06/2017 21



Compatibility Situations
Projects Using HMIs / HMI Controllers
The Vijeo-Designer software has its own rules which are defined in Vijeo-Designer (Help → User 
Manuals → 3 Before You Begin → 3.2 Compatibility).
Vijeo-Designer can open an application created by an earlier version and can automatically convert 
this application into the new version.
NOTE: The converted application can no longer be opened with an earlier version of Vijeo-
Designer.
By downloading the HMI application part with SoMachine V4.1 (or with Vijeo-Designer), you will be 
prompted to update the HMI runtime version.
NOTE: In case of an HMI controller, access to the controller with an earlier SoMachine version is 
no longer possible.

Projects with External Elements
If you did not follow the migration practices (see page 27) when using your previous SoMachine 
versions, you may encounter the following concerns with external elements:
 a project that contains a device description installed from an EDS file, such that the device 

cannot be recognized by the new SoMachine version. You must install the device in the Device 
Repository,

 a project which contains a library that is not part of the SoMachine installation, such that the 
library cannot be recognized by the new SoMachine version. You must add the library in the 
Library Manager.

Creating a Project in a New SoMachine Version

Overview
When you create a project in SoMachine:
 You may encounter device firmware compatibility (see page 23) concerns.
 You will not be able to open the project in an earlier SoMachine version because it detects that 

the project is incompatible.
22 EIO0000001684 06/2017



Compatibility Situations
Using a Device with an Earlier Firmware Version

Overview
When logging in or downloading a new or an updated project with a new version of SoMachine, 
you may encounter a compatibility concern with your current controller firmware:

In this popup, the requested version is the device description version of the active application; the 
online version is the firmware version of the controller.
In this case, updating the device firmware is necessary. Device firmware is provided with the 
SoMachine installation disks (managed by SoMachine Configuration Manager) or can be found on 
the Schneider Electric website: www.schneider-electric.com.
Refer to the migration considerations (see page 27) to understand how to avoid this situation in 
future versions of SoMachine.
Refer to the chapter Compatibility of Controller and Device Description Versions (see page 32) to 
understand the compatibility rules (which device version can be downloaded to which controller 
firmware version).
EIO0000001684 06/2017 23



Compatibility Situations
Using a New Version of Vijeo-Designer Software

Section 2.2
Using a New Version of Vijeo-Designer Software

Using a New Version of Vijeo-Designer Software

Overview
If you want to use Vijeo-Designer with SoMachine, you should not use a different version from the 
one provided with SoMachine.
For more information, refer to the compatibility chapter in the Appendix (see page 35).
24 EIO0000001684 06/2017



Compatibility Situations
Using a New Controller

Section 2.3
Using a New Controller

Using a New Controller

Overview
Schneider Electric updates the controller frequently providing new features and functions. 
Therefore there may be a difference between the version you receive as a new product, the current 
version being put into stock from the factory, and the version of your SoMachine installation.

Controller with an Earlier Firmware Version
You received a controller with a firmware version earlier than the one of the devices in your 
SoMachine project.
In this case, updating the controller firmware is necessary. Controller firmware is provided inside 
the SoMachine installation or can be found on the Schneider Electric website: www.schneider-
electric.com.
If you do not update your controller, you are able to log in to your controller only if the compatibility 
rule is respected (see page 32).

Controller with a Later Firmware Version
You may receive a controller with a firmware version later than the one of the devices in your 
SoMachine project.
In this case, updating the project (see page 20) is necessary.
Alternatively, consider downgrading the firmware of your controller.
NOTE: A project created with an earlier SoMachine version cannot be downloaded to a controller 
with a later SoMachine V4.1 compatible firmware.

Controller Running a Solution Project (S-Type)
If your controller is running a SoMachine V3.1 solution project, use one of the following options:
 Update (see page 20) your SoMachine V3.1 solution project to SoMachine V4.1 and update the 

controller firmware compatible to version 4.1.
 Change the firmware of the controller by the new firmware V3.1 (see page 33) supporting the 

application libraries. Device firmware is provided with the SoMachine installation disks 
(managed by SoMachine Configuration Manager) or can be found on the Schneider Electric 
website: www.schneider-electric.com.

Also refer to Compatibility of Legacy S-Type Devices (see page 37).
EIO0000001684 06/2017 25



Compatibility Situations
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Chapter 3
Migration Considerations

Project Archives Helping to Preserve Compatibility

Overview
Before you install a new version of SoMachine software, or when your project is finalized, you 
should create an archive of your project. The archive contains all files included and referenced in 
the project with settings and profiles.
Project archives provide the following advantages:
 You can extract the project archive to any computer with SoMachine installed. In this way, you 

can share your projects with others or run it on another computer.
 Creating an archive can help reduce compatibility concerns with later versions of SoMachine.
This chapter provides information on the specific settings that help to preserve compatibility.
For general information on creating project archives, refer to the SoMachine Central User Guide 
(see SoMachine Central, User Guide).

Settings Helping to Preserve Compatibility
When you create an archive on your local computer in the Main Menu of the SoMachine Central 
by executing the command Save Project as... → Save Archive..., the Project Archive dialog box 
opens.
In the Project Archive dialog box, the following topics can affect compatibility and therefore you can 
select them when appropriate:

Information Description
Download information 
files

When this is selected, the compile information (the *.compileinfo file) is saved with 
your project file.
This allows you to log in to the controllers with the archived project without 
rebuilding the project.

Referenced devices When this is selected, the devices in the Device Repository of your project are 
saved into the archive with their versions.
Devices installed with EDS files are included.

Referenced libraries When this is selected, the libraries in the Library Repository of your project are 
saved into the archive with their versions.
Third-party libraries are included.
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What Is in This Appendix?
The appendix contains the following chapters:

Chapter Chapter Name Page
A Compatibility Annexe 31
B Device Conversion 45
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Appendix A
Compatibility Annexe

Overview
This section provides the annexes regarding the compatibility between SoMachine versions.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Compatibility of Controller and Device Description Versions 32
Compatibility of HMI and Controller Versions 33
Compatibility of SoMachine and Vijeo-Designer Versions 35
Compatibility of SoMachine Projects Using DTM Devices 36
Compatibility of Legacy S-Type Devices 37
Compatibility of Controller Connection Mechanism 38
Compatibility of Namespaces 38
Compatibility of Libraries 39
Compatibility Limitations 40
SoMachine/CoDeSys Compiler Version Mapping 44
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Compatibility Annexe
Compatibility of Controller and Device Description Versions

Overview
Logic controller firmware and device description versions are made of 4 digits: X.Y.Z.T. 
An Application.app file can be downloaded to a controller if the device description used to create 
this file is compatible with the controller firmware.

Compatibility Rule 
The controller firmware and the device description are compatible if the following rules are 
respected: 
 X.Y digits must be identical 
 The Z digit of the controller must be greater or equal to the Z digit from the device description.
 T digit is irrelevant

Example
A device description version 2.0.20.30 of an M238 controller is compatible with the following 
controller firmware versions:
 2.0.20.11
 2.0.20.14
 2.0.20.30
 2.0.30.13
 2.0.31.3
But it is not compatible with the firmware versions 2.0.10.8.
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Compatibility of HMI and Controller Versions

Overview
When building a solution with some HMI and controllers communicating to each other, you must 
use controllers and HMI devices at the same firmware / runtime compatibility level.
When you download an application with an HMI from SoMachine, the HMI runtime is automatically 
updated to the latest version.

The table provides the relation between the SoMachine version, the controller firmware, and the 
HMI runtime for SoMachine V2.0 and V3.x versions:

NOTICE
COMMUNICATION INTERRUPTION
Do not use a different controller firmware version or a different HMI runtime other than that which 
is specified in the table below for the given SoMachine version.
Failure to follow these instructions can result in equipment damage.

SoMachine 
version used

V2.0 RL1 V2.0 RL2 V2.0 RL2 V3.0 V3.1

HMI runtime V5.1.1.1179 V5.1.11.1200 V5.1.20.1404 V6.0.0.212 V6.1.0.393
M238 firmware 
version

V2.0.20.11 V2.0.20.14 V2.0.20.30 V2.0.30.13 V2.0.31.10 or 
later

M258 firmware 
version

V2.0.1.2 V2.0.1.14 V2.0.1.36 V2.0.2.32 V2.0.31.27 or 
later

LMC058 
firmware version

V2.0.1.2 V2.0.1.14 V2.0.1.36 V2.0.2.32 V2.0.31.27 or 
later

ATV IMC 
firmware version

V1.1ie01 V1.1ie01 V1.1ie03 V1.1ie19 
patch 2

V1.1.2.13 or 
later

M241 firmware 
version

- - - - -

M251 firmware 
version

- - - - -
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The table provides the relation between the SoMachine version, the controller firmware, and the 
HMI runtime for SoMachine V4.0 and later versions:

SoMachine 
version used

V4.0 V4.1 V4.1 SP1 (SP1.1, 
SP1.2, SP2)

V4.2 V4.3

HMI runtime V6.1.4.236 V6.2.0.449 V6.2.2.252 
(V6.2.2.254, 
V6.2.3.217, 
V6.2.4)

V6.2.4.1xxx V6.2.4.1xxx

M238 firmware 
version

V4.0.1.16 V4.0.1.22 V4.0.1.23 V4.0.1.xx V4.0.1.xx

M258 firmware 
version

V4.0.1.24 V4.0.2.6 V4.0.2.33
(SP2: V4.0.2.51)

V4.0.3.2 V4.0.3.2

LMC058 
firmware version

V4.0.1.24 V4.0.2.6 V4.0.2.33
(SP2: V4.0.2.51)

V4.0.3.2 V4.0.3.2

ATV IMC 
firmware version

V4.0.1.15 V4.0.1.15 V4.0.1.15 V4.0.1.15 V4.0.1.15

M241 firmware 
version

V4.0.1.34 V4.0.2.11 V4.0.2.42
(SP2: V4.0.3.18)

V4.0.5.11 V4.0.6.x

M251 firmware 
version

- V4.0.2.11 V4.0.2.42
(SP2: V4.0.4.15)

V4.0.5.11 V4.0.6.x

*refer to the Release Notes for the latest firmware adaptations
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Compatibility of SoMachine and Vijeo-Designer Versions

Overview
If you want to use Vijeo-Designer with SoMachine, you should not use a different version from the 
one provided with SoMachine.
The table gives the Vijeo-Designer for each SoMachine version:

General Principle of Vijeo-Designer Installation
 A later major version of Vijeo-Designer is installed in parallel to an earlier major version (for 

example 6.1 in parallel to 6.0).
 A Vijeo-Designer service pack overwrites a Vijeo-Designer installation of the same major 

version (for example 6.1 SP2 overwrites 6.1 SP1.
NOTE: As an exception, Vijeo-Designer 6.1 SP4 is installed in parallel to Vijeo-Designer 6.1 
SP3 or earlier.

SoMachine 
Version

V1.0 V1.1 V2.0 RL1 V2.0 RL2 V3.0 V3.1 V4.0 V4.1
 SP1
 SP1.1
 SP1.2
 SP2

V4.2 / 
V4.3

Vijeo-
Designer 
Version

5.0.1 5.0.2 5.1 S20R8 5.1 S20R9 6.0 6.1 up 
to SP3

6.1 SP4 6.2.0
 SP2
 SP2.1
 SP3
 SP4

6.2.0 
SP4.1
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Compatibility of SoMachine Projects Using DTM Devices

Overview
Generally the DTM design supports only one DTM of a certain version on a PC.

Installing DTMs
Before you open a project using DTM devices, you have to install the respective DTMs using 
SoMachine Configuration Manager.

Launching SoMachine and Updating the Device Repository

Opening and Updating Your Project

Step Action Comment
1 After installing the DTMs, launch SoMachine. The SoMachine DTMs Monitor dialog 

box is displayed showing a List of new 
SoMachine DTMs found.

2 Select the DTMs you want to import to the Device 
Repository.

This is done by activating the check 
boxes in the Scan column.

3 Click Import selected DTMs. The selected DTMs are imported to the 
Device Repository.

Step Action Comment
1 After updating the Device Repository, open your 

project.
The Update project dialog box is 
displayed.

2 Select OK in the Update project dialog box. The devices (and DTMs) are updated.
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Compatibility of Legacy S-Type Devices

Overview
With SoMachine V4.1 no legacy controllers are installed.
That is, no S-type controllers are installed.
Also refer to section Using a New Controller (see page 25).

Replacement of S-Type Devices
After opening a project containing S-type devices the Update project dialog box (see page 17) lists 
the legacy devices (S-type) and in a second column the associated generic devices (G-type).
Click OK to convert the legacy devices to the associated generic devices automatically.

Legacy S-Type Devices Converted to G-Type Devices
M238 controllers
TM238LFAC24DRS0 TM238LFAC24DR
TM238LFDC24DTS0 TM238LFDC24DT
M258 controllers 
TM258LF42DTS0 TM258LF42DT
TM258LF42DT4LS0 TM258LF42DT4L
TM258LF66DT4LS0 TM258LF66DT4
TM258LF42DRS0 TM258LF42DR
XBTGC controllers
XBTZGCCANS0 XBTZGCCAN
XBTZGCANMS0 XBTZGCANM
LMC058 controllers
LMC058LF42S0 LMC058LF42
LMC058LF424S0 LMC058LF424
ATV IMC controller
VW3A3521S0 VW3A3521
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Compatibility of Controller Connection Mechanism

Overview
 SoMachine V3.1 and earlier supports the active path mechanism for connecting to controllers.
 From SoMachine V4.0 the IP address mechanism is supported in addition.
For detailed information refer to the respective chapters in the SoMachine programming guide 
(Communication Settings (see SoMachine, Programming Guide), Controller Selection 
(see SoMachine, Programming Guide)).

Restrictions for Legacy Controllers
For legacy controllers (firmware V3.1 compatible and earlier) the following functionalities are 
available:
 find controller
 select controller
 connect controller
For legacy controllers (firmware V3.1 compatible and earlier) the following functionalities are not 
available:
 identify controller
 get information

Communication Settings
You can edit the communication settings (see SoMachine, Menu Commands, Online Help) under 
Project Settings → Communication settings.
For a description of this command, refer to the SoMachine Menu Commands Online Help section 
of the SoMachine Online Help.

Compatibility of Namespaces

Overview
SoMachine V4.1 introduces a feature by which for some libraries it is mandatory to specify a 
namespace in front of each symbol used out of this library.
For details, refer to Namespace (see SoMachine, Functions and Libraries User Guide) in the 
SoMachine Functions and Libraries User Guide.
Therefore, after updating a project from an earlier SoMachine version, you might encounter 
undeclared symbol compiler error messages.
To solve this, write the corresponding namespace, followed by a dot, in front of the undeclared 
symbol.
38 EIO0000001684 06/2017



Compatibility Annexe
Compatibility of Libraries

Overview
It is possible to manage concurrent communication of EtherNet/IP and Modbus TCP devices with 
the TM251MESE controller. To make the libraries independent from the device network, the 
libraries, used to control some devices, have been updated in order to have the same namespace 
whatever the device network protocol used to control them.
Therefore, after updating a project from an earlier SoMachine version, you might encounter one of 
the following compiler error messages:
 Unknown type: SEMFDP…
 Unknown type: SEMFDM…
These messages are raised if your application was controlling the following devices on 
Modbus TCP:
 Lexium 32
 Altivar 32
 Altivar 71

Updating Your Project
During the update, two libraries are automatically replaced by other libraries:

Once the project is updated, you have to perform the following replacements:

For more information on the namespace, refer to General Description of Libraries (see SoMachine, 
Functions and Libraries User Guide).

The libraries... ...are replaced by...
 FieldbusDevicesModbusTcp, and
 FieldbusDevicesPLCOpen

 GMC Independent Lexium,
 GMC Independent ModbusTCP,
 GMC Independent Altivar, and
 GMC Independent PLCOpen MC.

If the application was using… …replace the deprecated 
namespace…

…by the new namespace…

PLCopen function blocks (name 
starting with MC_)

SEMFDP
(FieldbusDevicesPLCopen)

GIPLC
(GMC Independent PLCopen MC)

Vendor specific function blocks 
for Altivar (name ending with 
_ATV)

SEMFDM
(FieldbusDevicesModbusTCP)

GIATV
(GMC Independent Altivar)

Vendor specific function blocks 
for Lexium (name ending with 
_LXM)

SEMFDM
(FieldbusDevicesModbusTCP)

GILXM
(GMC Independent Lexium)
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Compatibility Limitations

Loading a Boot Application Created With SoMachine V4.1 to Controller Firmware Compatible With 
SoMachine V3.0

There is a rule in compatibility (see page 23) which says that it is not possible to log in to a 
controller which has an earlier firmware (for example V3.0) with a project created with a later 
SoMachine version (for example V4.1).
But by FTP or with a USB memory key it is possible to load a boot application created with 
SoMachine V4.1 to a controller running firmware V3.0. The boot application will not be loaded at 
next reboot and cannot run.
The controller will be in HALT state.
Update the device firmware to the required version.

Updating SoMachine V1.1 Projects
Update SoMachine V1.1 projects in a first step to SoMachine V3.1. After that, update to the latest 
SoMachine version.

Updating a SoMachine V3.1 Project to SoMachine V4.1 SP1 Has Influences on DTMs
After updating a project made in SoMachine V3.1 to SoMachine V4.1 SP1, the 
Advantys OTB DTM and the TM5-7 DTM may be unresponsive or unreliable. 
If this happens, copy and paste the same DTM. The new node will work fine. 
You can then remove the old DTM node.

New Process of Retrieving the State of CANopen Slaves with SoMachine V4.0
In SoMachine V3.1, it was possible to use internal variables implicitly created when adding a 
CANopen slave to access some information on the current state of the device. For example, 
MyOTB.nStatus or MyOTB.bSlaveAvailable. 

These internal structures are no longer supported in SoMachine V4.0 and later versions. Instead, 
use the GET_STATE function blocks of the CIA405 library to retrieve the state of your CANopen 
slaves.

Mapping Variables on Single Bits Feature Only for SoMachine V4.0 and Later
The feature that allows you to map variables on single bits is only available for devices that have 
been created with SoMachine V4.0 or later. 
In SoMachine projects that have been updated from an earlier version, this feature is not available 
for the existing / updated devices. 
To make the feature available for these devices, create a new device node and delete the old one.
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Updating a SoMachine V3.1 Project Requires Extensions for Libraries
When you update a SoMachine V3.1 project, error messages in the Messages view 
(see SoMachine, Menu Commands, Online Help) may indicate that the extensions for libraries are 
missing.
Add the required extension to the library:
Example:
GET_STATE --> CIA405.GET_STATE.

3S CanOpenStack Library 
If you use the 3S CanOpenStack library in your project, the following Build error may be detected 
and displayed in the Messages view (see SoMachine, Menu Commands, Online Help):
C0035: Program name or function block instance expected instead of 'xxx'. where 'xxx' is a POU 
inside your project (for example, a POU named START or STOP).
As the library 3S CanOpenStack is of the category Intern (not intended for direct usage), it is a best 
practice to enable the option Only allow qualified access to all identifiers in the Properties dialog 
box of this library for overcoming the Build error. 

Updating Projects with HMISCU/XBTGC
If you update a project created with SoMachine V3.1 including HMISCU/XBTGC devices and 
containing the HSC and PTO_PWM modules, the HSC and PTO_PWM nodes may be displayed 
with red crosses in the Devices tree after the update. This indicates that the devices are outdated.
To remove the red crosses, update the device manually by right-clicking the HMISCU/XBTGC 
nodes and executing the command Update Device... from the context menu and selecting the 
same device.
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Variables Defined in GVL of a Library Not Correctly Shared After Updating SoMachine V3.1 Projects
When you update a SoMachine V3.1 project, the message The POU xxx is no longer available 
within your compiled application but it is still configured in the symbol configuration may be 
displayed in the Messages view (see SoMachine, Menu Commands, Online Help). It indicates that 
variables defined in a GVL of a library are not correctly shared in the symbol configuration editor 
(see SoMachine, Programming Guide).
To share again this variable in the symbol configuration, proceed as follows:

Connecting to Controllers in Remote Subnets
In SoMachine V3.1, a Remote Connection tool is available for connecting to controllers in remote 
subnets.
In SoMachine V4.1 and later versions, connections to controllers in remote subnets are 
established with the Controller Selection view of the device editor (see SoMachine, Programming 
Guide) by using the Connection Mode types for Remote TCP. For connections via OPC, use the 
Static Remote Connections tab of the Gateway Management Console.
In SoMachine V4.2 and later versions, connections to controllers in remote subnets can be 
established from the Static Remote Connections tab of the Gateway Management Console. To 
open the Gateway Management Console, right-click the gateway icon in the Windows notification 
area. For further information, refer to the Gateway Management Console User Guide online help.

Direct Addresses of Type myvar AT %Mn : BOOL Cause Error Messages
When you build a legacy application (created with SoMachine V3.1 or earlier), with 
SoMachine V4.1 or later, the message Direct Address %M?n malformed may be displayed if you 
use direct addresses of the type myvar AT %Mn : BOOL in your variable declarations. 

You can skip this message by selecting Ignore.
In any case, this usage will lead to Build errors that will be displayed in the Messages view 
(see SoMachine, Menu Commands, Online Help).
To avoid these Build errors, replace the address declaration by the type 
myvar AT %MXn.0 : BOOL.

Step Action
1 Double-click the Symbol Configuration node in the Tools tree to open the symbol configuration 

editor inside the updated project in your SoMachine version later than SoMachine V3.1.
2 Deselect the variable that is not correctly shared.
3 Close the symbol configuration editor.
4 Reopen the symbol configuration editor.
5 Build the application.
6 Select the variable again in the symbol configuration editor.
42 EIO0000001684 06/2017



Compatibility Annexe
EtherNet/IP Adapter Removed During Update
If you have defined an M251 MESE EtherNet/IP adapter function on an Ethernet#1 connector in 
an application built with SoMachine V4.1 SP1 or earlier, and you intend to convert this application 
to a later version, then the EtherNet/IP adapter previously configured will be deleted.

Limitations for SoMachine V4.1 SP2 or V4.2 Applications Including the EtherNet/IP Adapter Service
Starting from firmware V4.0.4.x (SoMachine V4.1 SP2) for M251MESE and V4.0.5.x 
(SoMachine V4.2) for M241 and M251MESC, the EtherNet/IP adapter service has the following 
limitations:
 The File Object is removed.
 The Modbus Object is removed.
 The value displayed for the RPI (Requested Packet Interval) parameter is not valid for 

M251MESE with SoMachine earlier than V4.1SP2 and for M241 with SoMachine earlier than 
V4.2.

 The RUN/IDLE status of the PLC_R structure is not valid.
 The UCMM (Unconnected Message Manager) Error Count and Class 3 Error Count of the 

PLC_R structure are not valid.

Modbus IOScanner for Serial Line: Read/Write (FUNC23) Is Not Transformed Automatically 
Read/Write (FUNC23) used in Modbus IOScanner for Serial Line in SoMachine V3.1 or earlier 
is not automatically transfomed to Read (FUNC03) and Write (FUNC16) in SoMachine V4.1 or 
later if the slave does not support the Read/Write function.

Modify the application manually by separating the Read/Write function into one Read and one 
Write.

Devices Imported from EDS Files Are Not Updated
Whenever you update a legacy project file containing devices for which no new device description 
files are installed in the current SoMachine device repository, these devices are not recognized by 
SoMachine. This applies in particular to devices imported from EDS files.
To avoid this, install these devices before updating your project. For further information, refer to 
the chapters Using Existing SoMachine Projects (see page 22) and Migration Considerations 
(see page 27).

Updating Library Parameters of a POU
If you have renamed parameters of a POU for a library between versions, the old parameter names 
will still be used in the POU code. 
In order to use the new parameter names, execute the Update Parameters command 
(see SoMachine, Menu Commands, Online Help) manually on the corresponding POU call usage.
For a description of this command, refer to the SoMachine Menu Commands Online Help section 
of the SoMachine Online Help.
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SoMachine/CoDeSys Compiler Version Mapping

Overview
The following mapping table gives an overview of which CoDeSys compiler version is used by 
default in a certain SoMachine version.
SoMachine

The mapped display version is used for example in the Project Settings → Compile Options dialog 
and the Project Update dialog.

SoMachine Software Version Mapped Display Version CoDeSys Compiler Version
SoMachine V1.0 V1.0.10.0 3.2.2.43
SoMachine V1.1 V1.1.10.0 3.3.1.2
SoMachine V2.0 RL1 V2.0.18.8 3.3.1.40
SoMachine V2.0 RL2 V2.0.20.20 3.3.1.40
SoMachine V3.0 V3.0.14.5 3.4.1.50
SoMachine V3.1 V3.1.10.1 3.4.1.90
SoMachine V4.0 V4.0.0.0 3.5.3.60
SoMachine V4.1 V4.1.0.0 3.5.3.82
SoMachine V4.1 SP1 V4.1.0.1 3.5.3.83
SoMachine V4.1 SP1.1 V4.1.0.2 3.5.3.84
SoMachine V4.1 SP1.2 V4.1.0.3 3.5.3.85
SoMachine V4.1 SP2 V4.1.0.4 3.5.3.86
SoMachine V4.2 V4.1.0.4 3.5.3.86
SoMachine V4.3 V4.1.0.5 3.5.3.87
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Appendix B
Device Conversion

Conversion of ATV32 to ATV320 Devices

Overview
Convert an ATV32 device configuration to an ATV320 device configuration by using the SoMove 
configuration software. As a prerequisite, the configuration file (*.psx) corresponding to the ATV32 
device to convert is required.

Procedure Overview
The migration of ATV32 to ATV320 devices is performed in three steps that are described in this 
document:

How to Generate the ATV32 Configuration File
The following procedure describes how to generate the ATV32 configuration file (*.psx) directly 
from the device by using SoMove V2.6 or later:

Step Action
1 Generating the ATV32 configuration file (*.psx) (see page 45).
2 Converting the ATV32 device configuration to an ATV320 device configuration (see page 46).
3 Importing the converted ATV320 project into SoMachine (see page 46).

Step Action Result
1 Launch SoMove. The SoMove start page opens.
2 Execute the command Tools → Edit Connection / Scan. –
3 In the Edit Connection dialog box, select the connection 

settings that correspond to the ATV32 device you want to 
convert. For further information, refer to the SoMove 
online help.

–

4 Click Apply. The Edit Connection dialog box is closed.
5 Execute the command Transfer → Load from Device from 

the SoMove start page.
–

6 Select a file to save the SoMove project. –
7 Select the file type SoMove project files (*.psx). –
8 Click Save. The upload process starts.
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How to Convert ATV32 to ATV320 Devices
To convert an ATV32 to an ATV320 device, perform the following steps:

How to Import the Converted ATV320 Project Into SoMachine
To import the converted ATV320 device configuration into SoMachine, perform the following steps:

Step Action Result
1 Launch SoMove. The SoMove start page opens.
2 Execute the command Tools → Device Conversion. The Device Conversion dialog box 

opens.
3 Select the ATV32 configuration file (*.psx) that you 

want to convert, and click Open.
The Device Conversion for ATV32 
dialog box opens.

4 Select ATV320 from the Select Target list and click 
Convert.

The Select ATV320 dialog box opens.

5 Select the option ATV320 Book or ATV320 Compact 
according to your requirements.

The compatible Reference, Firmware 
Version, Supply Voltage, and Nominal 
Power parameters are displayed for the 
selected option.

6 Click OK. The message Device conversion is 
successful is displayed.

7 Click OK to close the message. The converted ATV320 project opens.

Step Action Result
1 Launch SoMove. The SoMove start page opens.
2 Execute the command Tools → Edit Connection / 

Scan.
–

3 In the Edit Connection dialog box, select the 
connection settings that correspond to the ATV320 
device you want to update. For further information, 
refer to the SoMove online help.

–

4 Click Apply. The Edit Connection dialog box is 
closed.

5 Execute the command Transfer → Store to Device. –
6 Close SoMove. –
7 Open your SoMachine project, and select Altivar 320 

in the Devices tree.
–

8 Upload the device configuration for the ATV320 
device. For more information, refer to the Device Type 
Manager (DTM) - User Guide (see SoMachine, Device 
Type Manager (DTM), User Guide).

–
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Glossary
A
application

A program including configuration data, symbols, and documentation.

C
configuration

The arrangement and interconnection of hardware components within a system and the hardware 
and software parameters that determine the operating characteristics of the system.

controller
Automates industrial processes (also known as programmable logic controller or programmable 
controller).

D
DUT

(data unit type) Along with the standard data types the user can define own data type structures, 
enumerationen types, and references as data type units in a DUT editor.

E
EDS

(electronic data sheet) A file for fieldbus device description that contains, for example, the 
properties of a device such as parameters and settings.

expansion bus
An electronic communication bus between expansion I/O modules and a controller.

G
GVL

(global variable list) Manages global variables within a SoMachine project.

I
I/O

(input/output)
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Glossary
P
POU

(program organization unit) A variable declaration in source code and a corresponding instruction 
set. POUs facilitate the modular re-use of software programs, functions, and function blocks. Once 
declared, POUs are available to one another.

program
The component of an application that consists of compiled source code capable of being installed 
in the memory of a logic controller.

R
RPI

(requested packet interval) The time period between cyclic data exchanges requested by the 
scanner. EtherNet/IP devices publish data at the rate specified by the RPI assigned to them by the 
scanner, and they receive message requests from the scanner with a period equal to RPI.
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